High School Technology Integration

Mathematics

Proposal

Department of Education
February, 2000
Acknowledgments

We gratefully acknowledge all who have contributed to the Senior High Mathematics Technology integration document. Special thanks is extended to Kerry Rioux and Laurie Callbeck at Three Oaks Senior High School and Lynn Coughlin at Bluefield High School for their expertise in developing the lesson plans. Appreciation is also extended in advance to those teachers who will field test this document. We look forward to their constructive criticism of this document and hope that it will be a spring board for future lessons using technology in the class room.

Ken Roper
Senior High Math/Science Consultant

Peter Griesbauer
IT Senior High Consultant
# Table of Contents

Preface .................................................................................................................. 4

Mathematics and Information Technology ............................................................ 5
  GCO A ............................................................................................................. 6
  GCO B ............................................................................................................. 8
  GCO C ........................................................................................................... 10
  GCO D .......................................................................................................... 12
  GCO E .......................................................................................................... 14
  GCO F .......................................................................................................... 16
  GCO G .......................................................................................................... 18

Appendix A ........................................................................................................... 20
  Grade X Lesson Plans ...................................................................................... 20

Appendix B .......................................................................................................... 35
  Grade XI Lesson Plans ................................................................................... 35

Appendix C .......................................................................................................... 46
  Grade XII Lesson Plans .................................................................................. 46

Appendix D .......................................................................................................... 55
  Lesson Plan Forms .......................................................................................... 55
Preface

This document is a continuation of Journey On (1999). To facilitate achieving the outcomes as outlined in the Atlantic Canada Math Foundation Document and the APEF specific curriculum outcomes in our Math Guides, it is essential that technology ve incorporated within the day-to-day classroom activities in Island schools. By providing learning opportunities beyond the traditional classroom, students are able to develop a broader spectrum of knowledge and skills which should facilitate life-long learning essential in today’s rapidly changing society.

This document recognizes that technology can play an instrumental role in improving problem-solving skills, communication, reasoning and making connections between mathematics and the real world. The teacher’s role will increasingly become one of being a facilitator and a resource which will provide students with the freedom to develop independent learning skills.

The layout of this document is as follows: The left page contains the Mathematics General Course Outcome (GCO). In the left column of this page selected Specific Course Outcomes (SCO) for Grades X, XI, and XII are listed. The right column provides examples of teaching activities pertaining to the SCOs. In a similar manner, the facing page contains the General Technical Out come (GTO) associated with the specified teaching suggestions and in its left column the corresponding Specific Technical Outcomes (STO). The right column of this page provides explanations and/or examples in regards to the technical skills in question.
Mathematics and Information Technology

Outcomes, Suggested Activities, and Instructional Implications.
<table>
<thead>
<tr>
<th>SCO: Grade X</th>
<th>Teaching Suggestions and Activities:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A2: analyze graphs or charts of situations to identify specific information.</td>
<td>A2 graph a linear function and determine its slope and y-intercept using a spreadsheet or graphing calculator.</td>
</tr>
<tr>
<td>A10: analyze graphs or charts of given situations to derive specific information in 3-D space, in statistics and in algebra.</td>
<td>A10 Ask students to graph statistical data and have students develop an understanding of interpolation and extrapolation using a spreadsheet and/or graphing calculator.</td>
</tr>
<tr>
<td>A12: demonstrate an understanding for and apply random numbers in probability and statistical calculations.</td>
<td>A12 Ask students to develop a random number generator using a spreadsheet or a random number generating program (eg. a program written in QBASIC or Visual Basic) to simulate a toss of a coin, roll of a die, or drawing of a lottery number.</td>
</tr>
</tbody>
</table>

| SCO: Grade XI | |
|-------------| A2 Ask students to graph a quadratic function and determine the coordinates of its vertex, the maximum and minimum, using either a spreadsheet or a graphing calculator. |

| SCO: Grade XII | |
|-------------| A2 Ask students to graph a trig function, using a spreadsheet or a graphing calculator by changing parameters such as frequency or amplitude. |
## GTO D: Record, organize, manipulate, and analyze data electronically

<table>
<thead>
<tr>
<th>STO: By the end of grade 12, it is expected that students will:</th>
<th><strong>Instructional Implications:</strong></th>
</tr>
</thead>
</table>
| D6: design in spreadsheets formulas incorporating functions. | D6 A formula combines values and operators into an algebraic expression. The result of this expression will appear in the cell into which the formula is placed and will change if one value in the formula is changed. One can use actual values (e.g. 3 + 6), cell references (e.g. A3 + A4), or a combination thereof (e.g. A3 - 4). A formula must begin with either a value (0..9), an operator (+ or -) or one of these symbols: (, @, #, $.
<p>| The mathematical operators are +, -, * (multiplication), / (division), and ^ (exponentiation). Logical operators are: &lt; (less than), &lt;= (less or equal), &gt; (greater than), &gt;= (greater or equal), = (equal), and &lt;&gt; (not equal) and the Boolean operators are: #NOT#, #AND#, and #OR#. Formulas can contain more than two values and operators and consequently the order of operation becomes important and can be tailored to the need of the user through the use of parentheses. |
| D8: identify the parts of a graph or chart and select the appropriate graph type for a given set of data. | Functions are built-in formulas and are part of the specific software. Functions begin with the @ sign which is followed by the name of the function (e.g. @SUM, @AVG..), open bracket, the argument (i.e. the values or range of values to be operated on) and the closed bracket. Multiple arguments are separated with commas. Examples: @AVG(A3..A10) this function will calculate the arithmetic mean of the values in cells A3, A4, A5...A10 inclusive. @ROUND(@AVG(A3..A10),2) this function combines actually two functions. The outer function (ROUND) acts upon the result of the inner function (AVG) and in this case, will round the average of the data from cells A3 to A10 to 2 decimals. Most spreadsheets contain a large amount of functions addressing the following categories: mathematical, statistical, strings (i.e. functions operating on characters and/or words), financial, logical, date and time and others. |
| D8 Most graphs will contain some or all of these components: Main and subtitles, x-axis, y-axis, legends, axis titles, and labels. All graphs are formed from data contained in the spreadsheet. The data are visually displayed within the X- and Y-axis boundaries. Each block of data which is graphed is called a series. A legend on the bottom of the graph identifies the data categories used in the graph. Labels describe the nature of the increments on the x-and y-axis. It is important to use the appropriate graph type for a given set of data. <strong>Bar graphs</strong> compare values of different items in specific categories or at discrete points in time. <strong>Line graphs</strong> show trends or progression of values over time. <strong>Pie graphs</strong> compare individual data to other values and to the whole. <strong>Stacked bar and area graphs</strong> show the relationship of each value to the total. <strong>XY graphs</strong> show the relationship of one series to another. |</p>
<table>
<thead>
<tr>
<th>SCO: Grade X</th>
<th>Teaching Suggestions and Activities:</th>
</tr>
</thead>
<tbody>
<tr>
<td>B1 : model (with concrete materials and pictorial representations) and express the relationship between arithmetic operations and operations on algebraic expressions and equations.</td>
<td>B1 Use the algebra-tile template in Corel Presentations to solve algebraic equations.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SCO: Grade XI</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B1 : model (with concrete materials and pictorial representations) and express the relationship between arithmetic operations and operations on algebraic expressions and equations.</td>
<td>B1 Use the algebra-tile template in Corel Presentations to solve algebraic systems of linear equations.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SCO: Grade XII</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B14 explore and apply the graphs of the inverses of the sine and cosine functions.</td>
<td>B14 Ask students to generate a table of values and, using a spreadsheet, create appropriate graphs.</td>
</tr>
</tbody>
</table>
GTO D: Record, organize, manipulate, and analyze data electronically
GTO F: Students will use technology to communicate information appropriately

STO: By the end of grade 12, it is expected that students will:

D6: design in spreadsheets formulas incorporating functions.

D7: identify and apply absolute and relative addressing

D8: identify the parts of a graph or chart and select the appropriate graph type for a given set of data.

F4: present their ideas on a given topic through a slide presentation.

---

**Instructional Implications:**

D6 please refer to the Mathematics GCO A section.

D7 The concepts of relative and absolute addressing become of paramount importance when copying a formula or function. Assume you have the following spreadsheet:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>90</td>
<td>50</td>
<td>65</td>
<td>85</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>50</td>
<td>40</td>
<td>45</td>
<td>70</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>25</td>
<td>30</td>
<td>40</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>45</td>
<td></td>
</tr>
</tbody>
</table>

In E1 you wish to calculate the average with the function: `@AVG(A1..D1)`. When you copy this function to E2 in order to calculate the average for this row, the spreadsheet will automatically adjust the function to read: `@AVG(A2..D2)` and it will, by default, adjust the argument relative to the location of the cell into which you copy the formula. This is called **relative addressing**. To prevent a cell reference from adjusting when you copy a formula or function, make the reference absolute by entering dollar signs ($) before the column and row coordinates.

Assume that we have placed in A10 a constant (6.3) and we would like to divide all averages by this constant. Our function in E1 would now read: `(@AVG(A1..D1))/A10`. Now if we copy the formula to E2 it will read: `(@AVG(A2..D2))/A11` since the spreadsheet will relatively adjust all cell references to one row down and since there is no value in A11 we obtain an error.

Since we wish to divide always by A10 regardless of the relative position of our formula we have to make this cell **absolute**: `(@AVG(A1..D1))/$A$10`

D8 please refer to the Mathematics GCO A section.

F4: The possibility to present an idea, the results of a research project, concepts and their applications, trends and observations through multi-media channels conforms to the idea of different learning styles. Most presentation software allows the user to place text, images and even sound on a computer generated slide with a preset background. The user has control over features such as formatting, text size, colour and placement, image size and placement, transition between slides and the speed of presentation (manual or automatic), and order of slides. Since presentation programs allow a multitude of effects, students should be aware that design is of paramount importance and that effects should be used to enhance an idea and not to distract from it. Presentation manuals from major corporations, which use this form of communication constantly, emphasize the importance of simplicity and the need to focus on the message and not on technical effects.
<table>
<thead>
<tr>
<th>SCO: Grade X</th>
<th>C1: Students will explore, recognize, represent, and apply patterns and relationships, both informally and formally.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teaching Sugg.</td>
<td>C1 Find a set of data, limited to a linear relationship, on the Internet (eg. Stats Canada: <a href="http://www.statcan.ca">www.statcan.ca</a>) and using a spreadsheet and/or graphing calculators identify dependent and independent variables and domain and ranges.</td>
</tr>
<tr>
<td>SCO: Grade XI</td>
<td>C1 Research on the Internet a famous mathematician and bring out some interesting features about his/her life. Also discuss in the paper the person’s major contributions to mathematics (eg. <a href="http://aleph0.clarku.edu/~djoyce/mathhist/chronology.html">http://aleph0.clarku.edu/~djoyce/mathhist/chronology.html</a>)</td>
</tr>
<tr>
<td>SCO: Grade XII</td>
<td>C26 Using a graphing software (eg. Paint Shop Pro or a specific geometric software) draw two dimensional geometric polygons and three dimensional polyhedrons and explore the relationship between radius and area and surface area and volume respectively.</td>
</tr>
<tr>
<td>SCO: Grade XII</td>
<td>C41 Obtain data from Environment Canada (<a href="http://weather.ec.gc.ca/">http://weather.ec.gc.ca/</a>) (eg. temperature, precipitation, sunshine hours, etc) and using a spreadsheet demonstrate the sinusoidal character of these data (Hint: the data may have to be plotted over several years) and determine the sinusoidal equation using regression analysis.</td>
</tr>
<tr>
<td>GTO C: Students will access, evaluate, and select information using technology.</td>
<td></td>
</tr>
<tr>
<td>GTO F: Students will use technology to communicate information appropriately.</td>
<td></td>
</tr>
</tbody>
</table>

| STO: By the end of grade 12, it is expected that students will: |
| C2: utilize efficient search strategies for simple and complex queries. |

| Instructional Implications: |
| C2: Regardless whether one searches a database, the Internet, a digital encyclopedia or similar digital containers of information, the quality of information will be contingent upon the formulation of the query. This observation gives rise to the consideration that perhaps the most influential impact of CIT is that the key to success does not (as in previous times) depend upon the knowledge of a particular piece of information but instead depends upon the skill with which one can obtain the required information. |

| C2: The tools and/or strategies employed in a query will depend upon the source of information (Internet, database, etc) but common to all are Boolean operators. Students should be familiar with these Boolean operators, namely, AND, OR, NOT, AND NOT and for the Internet: ADJ, and NEAR. |

| C2: The Internet offers additional search tools, such as: required and prohibited operators or flags (+ and - respectively), exact phrases, Natural language queries, pipes, wildcards and many more. Students should be familiar with the most often used search tools. |

| C2: Students should utilize the various Help features of Internet search engines. Search engines may differ among each other in the way a query must be formulated. For example, a number of search engines require Booleans to be written in capitals. |

| F5: utilize features in Graphics programs that allow editing and manipulation of objects. Such features may include but are not restricted to: layers, effects, filters, masks, colour replacements and cloning. |

| F5: Graphics programs (e.g. Paint Shop Pro) allow the creation of images (graphics and pictorial material) and their manipulation. Tools used for the creation of images are brushes, lines, and polygons. In addition, superimposing a grid on the image allows the user to determine the exact dimensions of any image component. The units of measurements are often pixels but can easily be changed to millimeters, centimeters, inches or points. Editing or manipulation of images is achieved with software tools such as clone brushes, colour replacement tool, erasers, and special effects are obtained through the application of filters and effects. One of the greatest breakthroughs in graphics design is the possibility to create an image in layers. An image created in layers is like an image that has been created with a number of acetates. Each acetate contains one component of the image and all acetates together render the completed image. This method allows the modification (editing, changing of colours and size, placement, etc) of each individual layer without affecting any other component in the image. Moreover, the order of the layers can be easily re-arranged and a layer that was a background in one completed image may become the foreground in the next. |
### GCO D:
Students will demonstrate an understanding of and apply concepts and skills associated with measurement.

<table>
<thead>
<tr>
<th>SCOS: Grade X</th>
<th>Teaching Suggestions and Activities:</th>
</tr>
</thead>
<tbody>
<tr>
<td>D14: solve problems involving measurement using bearings and vectors.</td>
<td>D14 Students use a graphics program (e.g., Paint Shop Pro or Geometers sketch pad) to visualize the Pythagorean theorem and by changing dimensions to prove the validity of the theorem in all cases - i.e. to observe the reliability of the theorem.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SCOS: Grade XI</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>D19: explore constructions for various geometric configurations and apply geometric properties to solve problems involving measurements.</td>
<td>D19 Use Geometers sketch pad to explore various constructions and induce geometric properties of various polygons.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SCOS: Grade XII</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>D14: solve problems involving measurement using bearings and vectors.</td>
<td>D14 Bearings and Vectors are essential in ship’s navigation in order to avoid the danger of grounding. The navigational method used is based upon proven geometric theorems. Assume a boat maintains course and speed and only one significant landmark is visible. The navigator must know the distance of the vessel from the mark (e.g., a lighthouse) in order to avoid grounding on rocks in the vicinity of the vessel’s course. The navigator takes a relative bearing of the lighthouse (e.g., relative to the course of the vessel) and notes the time of this bearing. He continues to take bearings of the same lighthouse until the second relative bearing is exactly double the relative angle of the first. He records again the time of this bearing. The distance run between bearings (easily calculated since time and speed are known) is also the distance from the lighthouse. Example: At 10:10 a skipper, on a vessel proceeding at 095° at a speed of 10 knots, takes a relative bearing of a lighthouse of 40° (i.e., regardless of the vessel’s actual course the heading of the vessel is assumed to be 000° and the bearing to the mark is measured from this base value. For example, if the vessel proceeds at a course of 095° and the bearing is 135° then the relative bearing is 40°). At 10:25 the second relative bearing is 80°. The distance run at 10 knots in 15 minutes is 2.5 nautical miles (1 knot = 1 nautical mile/hour). The lighthouse, is at the time of the second bearing, 2.5 nautical miles from the vessel. The skipper can consult his chart to see whether this distance is safe enough for his vessel’s course. Students could be asked to identify the geometric theorems underlying this navigational method and to use a graphics program to plot the course of the vessel and the first and second bearing to a given mark.</td>
</tr>
<tr>
<td>GTO F:</td>
<td>Students will use technology to communicate information appropriately.</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>STO: By the end of grade 12, it is expected that students will:</td>
<td><strong>Instructional Implications:</strong></td>
</tr>
<tr>
<td>F5: utilize features in Graphics programs that allow editing and manipulation of objects. Such features may include layers, effects, filters, masks, colour replacements and cloning.</td>
<td>F5: Graphics programs (e.g., Paint Shop Pro) allow the creation of images (graphics and pictorial material) and their manipulation. Tools used for the creation of images are brushes, lines, and polygons. In addition, superimposing a grid on the image allows the user to determine the exact dimensions of any image component. The units of measurements are often pixels but can easily be changed to millimeters, centimeters, inches or points. Editing or manipulation of images is achieved with software tools such as clone brushes, colour replacement tool, erasers, and special effects are obtained through the application of filters and effects. One of the greatest breakthroughs in graphics design is the possibility to create an image in layers. An image created in layers is like an image that has been created with a number of acetates. Each acetate contains one component of the image and all acetates together render the completed image. This method allows the modification (editing, changing of colours and size, placement, etc) of each individual layer without affecting any other component in the image. Moreover, the order of the layers can be easily re-arranged and a layer that was a background in one completed image may become the foreground in the next.</td>
</tr>
<tr>
<td>GCO E: Students will demonstrate spatial sense and apply geometric concepts, properties and relationships.</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>SCOs: Grade X</strong></td>
<td></td>
</tr>
<tr>
<td>E35: model real world phenomena with a variety of functions/relations.</td>
<td></td>
</tr>
<tr>
<td><strong>Teaching Suggestions and Activities:</strong></td>
<td></td>
</tr>
<tr>
<td>E35 Use the Internet to search for a set of data which can be presented linearly (some data which are often assumed to be linear will prove to be non-linear)</td>
<td></td>
</tr>
<tr>
<td><strong>SCOs: Grade XI</strong></td>
<td></td>
</tr>
<tr>
<td>E1: represent network problems as digraphs.</td>
<td></td>
</tr>
<tr>
<td>E1 Digraphs are used in planning the most efficient routes for airlines, garbage pickup, mail delivery, etc. Research the Internet for examples of network digraphs.</td>
<td></td>
</tr>
<tr>
<td><strong>SCOs: Grade XII</strong></td>
<td></td>
</tr>
<tr>
<td>E23: use technology to graph circles with a given centre and radius</td>
<td></td>
</tr>
<tr>
<td>E23 Use graphing calculators and/or a graphing software (e.g. Paint Shop Pro) to demonstrate that the equation of a circle ((x - h)^2 + (y - k)^2 = r^2) changes as the circle is enlarged or resized.</td>
<td></td>
</tr>
<tr>
<td>GTO C:</td>
<td>Students will access, evaluate, and select information using technology.</td>
</tr>
<tr>
<td>-------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GTO F:</td>
<td>Students will use technology to communicate information appropriately.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>STO: By the end of grade 12, it is expected that students will:</th>
</tr>
</thead>
<tbody>
<tr>
<td>C3: be familiar with various methods of searching the Internet and utilize the most appropriate method for a given query.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Instructional Implications:</th>
</tr>
</thead>
<tbody>
<tr>
<td>C3: There are at least five methods which can be utilized to obtain the desired information from the Internet. These are:</td>
</tr>
</tbody>
</table>

- **(A) Browsing** - refers to searching by following one’s whims and momentary inclinations. This is the least productive method of obtaining specific information but it is suitable for beginners to acquaint themselves with the Internet’s potential and to obtain ideas for projects or assignments.

- **(B) URLs** - magazines, journals and books often indicate the address (ie URL) of a specific source of information. Knowing this address eliminates searching to a large extend.

- **(C) Lists or Catalogues** - sites in which information is organized in subject trees are often referred to as Lists or Catalogues. If the topic is known, a search at a List site is often a worthwhile beginning.

- **(D) Search Engines** - are specific programs that create and maintain a searchable database and retrieve the specified information from it. Probably the most powerful search tool for the Internet but it also requires a learning curve since the quality of information from the databases depends largely on the quality of the posed query.

- **(E) E-mail** - The simple but often overlooked method of asking someone for help or information. Many educational and governmental organizations have “resident experts” which can be consulted and commercial enterprises are frequently very willing to provide advice and information.

| F5: utilize features in Graphics programs that allow editing and manipulation of objects. Such features may include but are not restricted to: layers, effects, filters, masks, colour replacements and cloning. |

| F5: Graphics programs (eg. Paint Shop Pro) allow the creation of images (graphics and pictorial material) and their manipulation. Tools used for the creation of images are brushes, lines, and polygons. In addition, superimposing a grid on the image allows the user to determine the exact dimensions of any image component. The units of measurements are often pixels but can easily be changed to millimeters, centimeters, inches or points. Editing or manipulation of images is achieved with software tools such as clone brushes, colour replacement tool, erasers, and special effects are obtained through the application of filters and effects. One of the greatest breakthroughs in graphics design is the possibility to create an image in layers. An image created in layers is like an image that has been created with a number of acetates. Each acetate contains one component of the image and all acetates together render the completed image. This method allows the modification (editing, changing of colours and size, placement, etc) of each individual layer without affecting any other component in the image. Moreover, the order of the layers can be easily re-arranged and a layer that was a background in one completed image may become the foreground in the next. |
GCO F: Students will solve problems involving the collection, display, and analysis of data.

Teaching Suggestions and Activities:

F1 Design a survey of an opinion, new product, music, or favourite food, etc. Organize and display the data using a spreadsheet as histograms. Discuss with the students the various methods of sampling (eg. stratified, random, systematic, clustered, etc)

F34 Collect data from the Internet representing quadratic relationships (eg. launching angles of golf balls in order to achieve maximum distance). Use a spreadsheet or graphing calculator to illustrate the findings.

F10 Collect data from the Internet or other sources representing trigonometric (eg. variation by season of: temperature, precipitation, tidal standings, etc.), or exponential (eg. growth of money through investment, world population, etc.), or logarithmic (eg. sound levels, Richter scale, etc.) relationships and use a spreadsheet or graphing calculator to obtain the curve of best fit and its equation. For example, the Canadian Hydrographic Service of the Department of Fisheries and Oceans publishes on the Internet the times of tidal Highs and Lows for selected places (http://www.chshq.dfo.ca/chs_hq/nautpubl/tides2000/MAR2000/T_CHR.html) but in order to obtain the height in feet and/or metres, one needs to consult the tide book for the year in question.
| GTO C: | Students will access, evaluate, and select information using technology. |
| GTO D: | Record, organize, manipulate, and analyze data electronically |

**STO:** By the end of grade 12, it is expected that students will:

- **C3:** be familiar with various methods of searching the Internet and utilize the most appropriate method for a given query.
- **D6:** design in spreadsheets formulas incorporating functions.
- **D8:** identify the parts of a graph or chart and select the appropriate graph type for a given set of data.

**Instructional Implications:**

- **C3** Please refer to the Mathematics GCO: E section
- **D6** A formula combines values and operators into an algebraic expression. The result of this expression will appear in the cell into which the formula is placed and will change if one value in the formula is changed. One can use actual values (eg. 3 + 6), cell references (eg. A3 + A4), or a combination thereof (eg. A3 - 4). A formula must begin with either a value (0..9), an operator (+ or -) or one of these symbols: (, @, #, $.

  The mathematical operators are +, -, * (multiplication), / (division), and ^ (exponentiation). Logical operators are: < (less than), <= (less or equal), > (greater than), >= (greater or equal), = (equal), and <> (not equal) and the Boolean operators are: #NOT#, #AND#, and #OR#.

  Formulas can contain more than two values and operators and consequently the order of operation becomes important and can be tailored to the need of the user through the use of parentheses.

  Functions are built-in formulas and are part of the specific software. Functions begin with the @ sign which is followed by the name of the function (eg. @SUM, @AVG...), open bracket, the argument (ie. the values or range of values to be operated on) and the closed bracket. Multiple arguments are separated with commas. Examples:

  - @AVG(A3..A10) this function will calculate the arithmetic mean of the values in cells A3, A4, A5...A10 inclusive.
  - @ROUND(@AVG(A3..A10),2) this function combines actually two functions. The outer function (ROUND) acts upon the result of the inner function (AVG) and in this case, will round the average of the data from cells A3 to A10 to 2 decimals.

  Most spreadsheets contain a large amount of functions addressing the following categories: mathematical, statistical, strings (ie. functions operating on characters and/or words), financial, logical, date and time and others.

- **D8** Please refer to the Mathematics GCO: A section
<table>
<thead>
<tr>
<th>GCO G: Students will represent and solve problems involving uncertainty.</th>
<th>Teaching Suggestions and Activities:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SCOs: Grade X</strong></td>
<td>G4 Use the Internet or other resources to obtain information on the sampling procedures of polls. How were the subjects sampled, how many subjects?, etc. Can you have confidence in the findings if this information is missing? (eg. can we trust polls regarding the popularity of politicians or political parties, etc).</td>
</tr>
<tr>
<td>G4: interpret and report on the results obtained from surveys and polls, and from experiments.</td>
<td><strong>SCOs: Grade XI</strong></td>
</tr>
<tr>
<td><strong>SCOs: Grade XII</strong></td>
<td>G4 Find on the Internet results of polls or surveys and interpret and report on those results using a word processor incorporating, if necessary, the raw data and graphs from a spreadsheet.</td>
</tr>
<tr>
<td>G4: interpret and report on the results obtained from surveys and polls, and from experiments.</td>
<td></td>
</tr>
<tr>
<td><strong>GTO C:</strong></td>
<td><strong>Students will access, evaluate, and select information using technology.</strong></td>
</tr>
<tr>
<td><strong>GTO E:</strong></td>
<td><strong>Students will use a variety of technologies to create new information in the form of written text and other ways of representing.</strong></td>
</tr>
</tbody>
</table>

**STO:** By the end of grade 12, it is expected that students will:

- **C3:** be familiar with various methods of searching the Internet and utilize the most appropriate method for a given query.

- **E3:** integrate documents produced with a word processor into other software and/or integrate data from other software into a word processing document.

**Instructional Implications:**

- **C3** Please refer to the Mathematics GCO: E section

- **E3:** Some problems still require a number of stand-alone programs if for no other reason than that certain tasks are easier managed by software which has been created for their purpose. The problem then arises how to “cut and paste” the information from one software into another. Particularly, graphics images can pose a problem since they come in a wide variety of formats, some of which are however not understood by the word processing program. This problem frequently involves the use of a third program, i.e. a translation program which renders the image in a format understood by the word processor. Similar problems exist in multi-media documents (eg. sound, videos). The process invariably involved requires planning and organization and once this has been addressed the task loses its complexity. For example, to import an image from the Internet (eg. a .jpg image) may involve these steps:
  
  - Obtain the image from the Internet and save it.
  - Open the translation software (eg. Paint Shop Pro or LView Pro) and open the Internet image in this software.
  - Save the Internet image in a file format understood by the word processor (eg. Word Perfect understands: .bmp, .wpg formats).
  - Insert the newly saved image in the word processing document.
Appendix A

Grade X Lesson Plans
Title:

PEI Election 2000
Statistical Analysis

Readiness Activities

- Students should:
  - Have an understanding of random sampling and sampling techniques.
  - Know how to set up frequency distribution tables and know how they work and what the outcome represents.
  - Know how to read and identify pie charts, bar graphs and histograms.
  - Have all sampling of data completed and data

Description

This assignment is a statistical analysis of Election 2000 (although any results from previous or current elections could be used). Data is collected and placed in a spreadsheet and is then analyzed through comparisons of pie charts and bar graphs. In addition to the typical Quattro Pro formulas and functions, students will use the data to create frequency distribution tables using Quattro Pro tools. Students are then encouraged to present the information in a written or oral report.

We suggest this assignment is to be used in conjunction with a random sampling project. Our original plan was to have students poll (using a valid random sampling technique) their peers to determine the popular political party for the province and determine the results for the actual results and comparisons drawn between the sample and the actual results. This lesson plan will require approximately 2-3 periods.

Materials

- Quattro Pro (6.0)
- Students all need log-ins
- Data (either collected or actual results)
Title: PEI Election 2000
Statistical Analysis

Learning Outcomes

Curriculum

Students will:

• Analyse graphs or charts of given situations to derive specific information in 3-D space, in statistics and in algebra (A10).

• Construct various displays of data (F4).

• Analyse and interpret displays and describe the relationships.

• Draw conclusions and communicate results about distributions of data (F6).

Technology

Students will:

• Use spreadsheet software to create graphical representations of data.

• Use spreadsheet software to create frequency distribution tables to display data and create bar graphs.
Title: PEI Election 2000
Statistical Analysis

Instructions

• Set up spreadsheet with districts lined down the first columns (starting in A2). If the speed fill button is used, you will only need to start the sequence and Quattro Pro will fill in the rest of the numbers for you.

• Starting in B1, place the names of the political parties (Liberal, NDP, PC) in columns B, C, and D. This order will correspond with the political colours to the default colours (trial and error!). If you want to set up your own order, we suggest that you change graph colours to correspond to the political colours.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Liberal</td>
<td>NDP</td>
<td>PC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>District 1</td>
<td>726</td>
<td>176</td>
<td>1535</td>
<td>2437</td>
</tr>
</tbody>
</table>

• After filling in the data, use the formula @sum(B2..D2) in cell E2 to calculate the total number of voters for each district. Again, use the speed fill button to copy the formula down for all districts. See the example below.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Liberal</td>
<td>NDP</td>
<td>PC</td>
<td>Total Voters</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>District 1</td>
<td>726</td>
<td>176</td>
<td>1535</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>District 2</td>
<td>826</td>
<td>47</td>
<td>1791</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>District 3</td>
<td>827</td>
<td>99</td>
<td>1807</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>District 4</td>
<td>865</td>
<td>65</td>
<td>1379</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>District 5</td>
<td>687</td>
<td>41</td>
<td>1668</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>District 6</td>
<td>937</td>
<td>143</td>
<td>1611</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>District 7</td>
<td>852</td>
<td>249</td>
<td>2399</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>District 8</td>
<td>982</td>
<td>163</td>
<td>1737</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>District 9</td>
<td>1080</td>
<td>214</td>
<td>1992</td>
<td></td>
</tr>
</tbody>
</table>

• Next, calculate the percent of votes for each party in each district. Start in F1 and place the title Percent Liberals. In G1 place the title Percent NDP, and in H1 place the title Percent PC.

• To calculate the % use the formula +B2/E2 for the Percent Liberals Column, +C2/E2 for
• the Percent NDP column, and +D2/E2 Percent PC column. Use speed fill to copy the formula. This formula divides the number of voters per party by the total number of voters.

• Values will be decimals. To change them to percents, highlight the blocks (percent values) and right click the mouse. Change the numeric format to percent with the desired number of decimal places.

• Now that all the data is in and the calculations are made it is time to make a graphical comparison. We decided that the most meaningful comparison would be of local ridings. If students did a poll prior to the election, it would also be interesting to compare the results with the actual tallies.

• For the purpose of a demonstration, we will use districts 19 to 22. Please note that it is easier to compare districts that are in sequence within the spreadsheet, but you are not limited to this procedure (see hints for elaboration).

• Select blocks beginning with the district numbers and include the three party votes.

<table>
<thead>
<tr>
<th></th>
<th>District 18</th>
<th>1223</th>
<th>267</th>
<th>2135</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>District 19</td>
<td>1002</td>
<td>153</td>
<td>1900</td>
</tr>
<tr>
<td>20</td>
<td>District 20</td>
<td>690</td>
<td>218</td>
<td>2654</td>
</tr>
<tr>
<td>21</td>
<td>District 21</td>
<td>1246</td>
<td>403</td>
<td>1674</td>
</tr>
<tr>
<td>22</td>
<td>District 22</td>
<td>1194</td>
<td>368</td>
<td>1626</td>
</tr>
<tr>
<td>23</td>
<td>District 23</td>
<td>1094</td>
<td>416</td>
<td>1118</td>
</tr>
<tr>
<td>24</td>
<td>District 24</td>
<td>1126</td>
<td>160</td>
<td>1209</td>
</tr>
</tbody>
</table>

• Once the block is selected, click on the “Perfect expert button from the help menu.

• The expert button will bring up the Experts window. Select the “Add Graphics” button and then the “Create Chart” button.

• The Graph Expert will guide you through a series of steps. The data we are graphing is A:A20..D23. On this first window, ensure that the Swap rows/columns option is marked.
• Proceed to the next step.

• In Step 2 of 5, select the pie chart option and proceed to the next step.

Now choose one of the multiple pie options so that the districts can all be displayed in one graph window and go to the next step.

• Step 4 of 5 allows you to change the colour scheme. If you have followed our advice, proceed to the next step (use default colours).

• Step 5 of 5 allows you to create a title and sub-title for the graph. Enter in appropriate titles and select the Graph Window destination before clicking on CreateGraph. This will place the graph at the back of the spreadsheet for easier access.

• The graph window will be displayed as shown.
• The districts are not identified, and the pieces of the pie are not labeled. To do this right click in the graph window and select Series. In the X-Axis box place B1..D1 as shown below and click OK.

![Chart Series](image)

• Your comparison graph is now complete. Please note, if you minimize or close your graph window you can access it by clicking the Speed Tab at the bottom by the page tabs.

FREQUENCY DISTRIBUTION TABLES

• To create a frequency distribution, set up a bin showing the intervals you want to analyze. The block must be a single column with a column of blank cells to the right (for the results). The numbers must appear in ascending order, but the intervals can be unequal. The first number in the bin block represents any value less than or equal to that number. The remaining bin block numbers represent all values greater than the previous entry, up to and including that number.

• We want to set up frequency distribution tables for the percent of votes for each party. For this demonstration we used Percent PC and set up column headings interval and frequency as shown below. You decide (given the data) the appropriate intervals to list.

![Frequency Table](image)

• Note that the intervals are listed in decimal form. This is because the values are percents (decimals formatted as percents). To change the interval block to represents percents, select the block, right click to get the block properties and change the numeric format to percent.

• To create the frequency table choose **Tools ➤ Numeric Tools ➤ Frequency** from the Menu Bar.

• Enter the requested data and choose OK to generate the frequencies in the column to the right.
of the bin block. The Value Blocks will be column of Percent PC and the Bin Block will be the column listing the intervals.

- The results block is one cell longer than the bin block; its last cell contains the number of values found that were greater than the final number in the bin.

- Note: Frequency results aren’t updated automatically. If you change data in the values block or the bin, use Tools ➤ Numeric Tools ➤ Frequency again to recalculate the distribution.

- To create a bar graph of the frequency distribution, select the frequency column (without the column heading) and use the Expert button to create a graph (select Graph Expert).

- In Step 2 of 5 select the Bar button and move on to the next step.

- Continue on to the next step until at Step 5 of 5. At this window fill in appropriate titles and ensure that the destination is the graph window. Create the graph.

To finish the graph, right click the graph window and select Series. In the X-Axis box put in the interval column. This will label the x-axis with the interval percents.

Now that the graphs are made, students are to utilize the information to create an analysis, to draw connections or to point out similarities or contrasts. It is strongly recommended that students use another software package to present their results (WordPerfect for written reports and Presentations for oral reports).
Title:
PEI Election 2000
Statistical Analysis

Hints

• Since most people who type expect enter to bring them down a line, set up Quattro Pro so that enter will move cell selector on enter key. To do this, right click in the Title Bar, select General and choose the appropriate option.
• Placing the parties in the order Liberal, NDP and then PC will correspond political colours to Quattro Pro default colours.
• When selecting districts that are not in sequence select those in sequence according to directions given and then in the graph series box separate cells with a comma. For example B20..B22, B24 (you would do this in the 1st, 2nd, and 3rd series boxes).

Suggestions for Other Activities

See Addison Wesley Text: Mathematics 10
Page 94-95 Bird Eggs
Page 546 Setting up Frequency Tables
Page 571 Coincident Birthdays

Note: These activities do not reinforce the same curriculum outcomes

Resources

Quattro Pro V 6.0 User’s Guide
Title: Algebra Tiles with Word Perfect Draw

Description
Students will create pictorial representations of algebra tiles using the Draw feature of Corel Word Perfect. This lesson plan will require approximately two periods.

Readiness Activities
Students should
• be familiar with the concept of representing algebraic expressions using tile models to perform operations such as addition, subtraction, multiplication and factoring of polynomials.
• It is also assumed teachers will have a basic working knowledge of Corel WordPerfect for Windows.

Materials
• A user ID and password for each student in the class.
• Ensure WordPerfect is assigned to each student group.
Title: Algebra Tiles with Word Perfect Draw

Learning Outcomes

Curriculum

Students will:

(a) Model (with concrete materials and pictorial representations) and express the relationship between arithmetic operations and operations on algebraic equations.

(b) Use concrete materials, pictorial representations and algebraic symbolism to perform operations on polynomials.

Technology

Students will: utilize the graphics features of the word processing software and/or presentation software.
Title:

Algebra Tiles with Word Perfect Draw

Instructions

The Draw feature of WordPerfect will be used to draw pictorial representations of algebra tiles.

Preparing the document

Open a new WordPerfect document and activate the Draw feature by choosing the Draw icon, or from the Tools menu, choose Draw. The Draw toolbar and Draw area should now be visible on the screen. The Draw area may be enlarged by positioning the mouse pointer in the corner of the Draw area until it changes to a double arrow and dragging the mouse to the desired size. If at any time the Draw toolbar and Draw area disappear from the screen it is the result of clicking the mouse outside the Draw area. To reactivate the Draw area, place the mouse in the vicinity of the Draw area and double click the mouse. Drawing will be easier if the Snap to Grid option is turned on with the Grid Snap icon, or from the View menu, choose Grid/Snap, and then select Snap to Grid.

Drawing an X² Tile

Draw an X² tile inside the Draw area by choosing the Rectangle icon, holding down the Shift key, and dragging the mouse to create a convenient sized square, as illustrated in Figure 1.

Drawing an X Tile

Draw an X tile by choosing the Rectangle icon and dragging the mouse to create a vertical rectangle whose height is equal to that of the X² tile. Create a horizontal rectangle with the same dimensions as the vertical rectangle, as illustrated in Figure 2.
Instructions continued....

**Drawing a One Tile**

Draw a one tile by choosing the **Rectangle** icon, holding down the Shift key, and dragging the mouse to create a small square whose dimensions are equal to the width of the X tile, as illustrated in Figure 3.

![Figure 3](image)

**Copying Tiles**

Additional tiles may be created by selecting the desired tile to be copied. To select a tile, choose the **Select Object** icon which looks like the mouse pointer from the Draw toolbar. From the **Edit** menu, choose **Copy** and then choose **Paste**. The new tile is superimposed over the original tile and can be moved to any location by clicking the left mouse button over the tile and dragging it to a new location.

![Figure 4](image)

**Applications**

The tile representations can be manipulated to represent algebraic operations such as addition, subtraction, or multiplication of polynomials. To move the tiles into desired positions from the **Draw** toolbar, choose the **Select Object** icon, and select the tile by holding down the mouse and dragging to the desired location. See Figure 4 for an example of multiplication of polynomials and texturing.

![Figure 4](image)
Suggestions for Other Activities

Students can also investigate the Rotate option by selecting the object to rotate and from the Edit menu choose Rotate. Position the mouse pointer on the corner of the object until it turns into a double arrow and then drag the mouse until the object is in the desired position. This feature can be used when creating vertical and horizontal X tiles.

- The process of factoring by using tiles may also be demonstrated with the pictorial tile representations, assuming students have covered this topic area in the classroom.
- More advanced pictorial representations of tile such as $Y^2$, $Y$, and $XY$ may also be created and used in the algebraic operations.
- Use the Tile template on your server to manipulate tiles.

Hints

- It may be advantageous to add color or texture to the tiles for printing. Similar tiles should be represented similarly. Select the tile, then from the Draw toolbar, choose the Fill Colors icon or the Fill Attributes icon. Negative tiles should be represented by white tiles.
- As previously mentioned in the instructions, the Snap to Grid option should be turned on to ensure easier alignment of objects.
- Turning the grid option on makes it easier to draw some diagrams. From the View menu, choose Grid/Snap, and then select Grid.
Title:
Algebra Tiles with Word Perfect Draw

Resources
- WordPerfect - A Manual for Island Teachers
- Corel WordPerfect Help Menu
Appendix B

Grade XI Lesson Plans
Title: History of Mathematics

Mathematics
Grade 10, 11, or 12
Historical Perspective
One-Computer Classroom or Computer Lab
Kerry Rioux

Description
Students will research on the Internet a Mathematician who has made a major contribution to the field, or a mathematical concept, idea or symbol and give a short (3-5 minute) presentation on the topic. Expect to use three classes in the computer room and about two days for presentations. To shorten up presentation time, groups could be assigned or oral presentation could be omitted completely.

Readiness Activities
Students should
• have a working knowledge of Netscape and WordPerfect or Corel Presentations.

Materials
• Computer lab for 2-3 classes (not necessarily consecutive days) equipped with Internet capabilities as well as WordPerfect and Corel Presentations.
Title: History of Mathematics

Grade 10, 11, or 12

Historical Perspective

Learning Outcomes

Curriculum

Students will: gain an appreciation of the history of mathematics by studying and presenting one mathematician and his/her major contribution.

Technology

Students will: develop a working knowledge or enhance their knowledge of Internet Explorer and its various search engines as well as WordPerfect and/or Corel Presentations to share their findings.
Title: History of Mathematics

Instructions

Students are to search the Internet to find information on Mathematicians and/or mathematical ideas or symbols (eg. Pi) and select one which they find particularly interesting. They will continue to use the internet to find various sites with information on the selected topic (3 websites could be set as a minimum number). They are then to prepare their information for presentation using WordPerfect or Corel Presentations. The oral presentation to the class should be a maximum of five minutes using any of the above technology to enhance their findings.
Title: History of Mathematics

Hints
In reference to the Website listed below the name in “blue” are links to information. Others are names which must be searched in other ways.

Suggestions for Other Activities
Could set up groups to explore Mathematicians by continents or by centuries.

Students could explore the history and development of mathematical ideas or concepts (eg. the use of zero) or symbols (eg. Pi).

Resources
A website with literally hundreds of Mathematicians and links is:

http://www.aleph0.clarku.edu/~djoyce/mathhist/chronology.html
http://forum.swarthmore.edu/dr.math
Title: Matrices with Quattro Pro

Description
Students will use the spreadsheet software Corel Quattro Pro, to perform operations such as addition, subtraction, scalar multiplication, and multiplication of matrices, as well as, to calculate inverses of matrices. This lesson plan will require approximately one to two periods.

Readiness Activities
Students should
• have a basic introduction to the use of Corel Quattro Pro in terms of inputting data into cells.
• knowledge of the operations performed on matrices.

Materials
• A user ID and password for each student in the class.
• Ensure Quattro Pro is assigned to each student group
• Individual student discs to save files on in case teacher wants project passed in on disc or to have a back-up copy.
Title: Matrices with Quattro Pro

Learning Outcomes

Curriculum

Students will:  
(a) Demonstrate an understanding of the properties of matrices and apply them.

(b) Explain why and apply the fact that matrices are not commutative under multiplication.

Technology

Students will:  
(a) Acquire and/or enhance spreadsheet skills.

(b) Design in spreadsheet formulas incorporating functions.

(c) Identify and apply absolute and relative addressing.
Title: Matrices with Quattro Pro

Instructions

The spreadsheet software Corel Quattro Pro will create matrix representations and perform operations on the matrix representations.

Teacher can specify the matrices operation which must be demonstrated by the student. For example, the addition of 3 X 2 matrices, subtraction of 2 X 4 matrices, multiplication of a 2 x 3 and 3 X 1 matrix, scalar multiplication, or the calculation of the inverse of a 3 X 3 matrix.

Preparing the Spreadsheet

Open a new blank spreadsheet. Have students attach titles to each matrix which is created, i.e. A, B, C. Thus, when the operation of addition is applied to two matrices, the sum matrix will have a title called A+B. Have students input numerical data into cells so as to create matrices of the desired size.

Creating Sum and Difference Matrices

Create a new matrix that will contain the sum or difference of the previous matrices. Label this matrix A+B or A-B. In the upper left cell of the matrix, enter the addition formula of the sum matrix. A formula must begin with a numeric symbol such as an equal sign (=) or an addition sign (+). The formula must also include the cell coordinates from which the data is originating, for example =A2+B2. See Figure 1 for an example of formulas.

Instead of re-entering formulas into every cell of the sum matrix, formulas can be copied into their respective cells. There are several methods of copying formulas. Select the cell which contains the formula to be copied. From the Edit menu choose Copy. Highlight the new cells where the similar formula will be applied by clicking and dragging the mouse. From the Edit menu choose Paste. This should distribute the formula throughout the cells.

Creating Product Matrices

In the upper left cell of the matrix, enter the multiplication formula of the product matrix. A formula must begin with a numeric symbol such as an equal sign (=) or an addition sign (+). The formula must also include the cell coordinates from which the data is originating.

To prevent a cell reference from adjusting when you copy a formula, make the cell reference absolute by entering a dollar sign ($) before the column and/or row coordinates. It is important to note that the column letters in the first matrix coordinate must be preceded by a dollar sign ($) to restrict the calculations to theses columns. Likewise, the row numbers from the second matrix coordinate
Instructions continued....

must be preceded by a dollar sign ($) for the same reason. See Figure 2 for an example of formulas.

Instead of re-entering formulas into every cell of the product matrix, formulas can be copied into their respective cells. Select the cell which contains the formula to be copied. From the Edit menu choose Copy. Highlight the new cells where the similar formula will be applied, by clicking and dragging the mouse. From the Edit menu choose Paste. This should distribute the formula throughout the cells.

Figure 1

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td></td>
<td></td>
<td>B</td>
<td></td>
<td></td>
<td>A + B</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>2</td>
<td>5</td>
<td>6</td>
<td></td>
<td></td>
<td>=A2+D</td>
<td>=B2+E2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>4</td>
<td>7</td>
<td>8</td>
<td></td>
<td></td>
<td>=A3+D</td>
<td>=B3+E2</td>
</tr>
</tbody>
</table>

Figure 2

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>A * B</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>2</td>
<td>5</td>
<td>6</td>
<td></td>
<td></td>
<td>=($A2*$C2) +($E2*$F3)</td>
<td>=($A2*$E2) - ($B2*$E3)</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>4</td>
<td>7</td>
<td>8</td>
<td></td>
<td></td>
<td>=($A3*$C3) +($E3*$F3)</td>
<td>=($A3*$E2) - ($B3*$E3)</td>
</tr>
</tbody>
</table>

Figure 3

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td></td>
<td></td>
<td>B</td>
<td></td>
<td></td>
<td>A * B</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>2</td>
<td>5</td>
<td>6</td>
<td></td>
<td></td>
<td>=$A$2*$D$2</td>
<td>=$A$2*$E$2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>4</td>
<td>7</td>
<td>8</td>
<td></td>
<td></td>
<td>=$A$3*$D$3</td>
<td>=$A$3*$E$3</td>
</tr>
</tbody>
</table>
Hints

• In order to input numeric values from the number pad ensure the Num Lock feature on the keyboard is activated.

• If you are entering data in one column and want the cell selector to move down a row each time you press Enter you must right-click the Quattro Pro title bar at the top of your document and choose General. Then check Move Cell Selector on Enter Key.

• Teachers may want students to print the formulas they have entered into the cells. This will ensure that the student have used the formula feature rather than performing the calculations manually. From the File menu choose Print, choose Sheet Options, and then select Cell Formulas under the Print Option. This will print a sheet which contains the information found in each cell, whether it be a numeric value or a formula.

• Grid lines do not automatically appear when the spreadsheet document is printed. If they are desired they may be added by highlighting the portion of the spreadsheet to contain grid lines. Right click on the mouse, choose Block Properties, then choose Line Drawing. Choose the option All, and choose a line type.

• To change the width of a column, move the mouse to the top of the spreadsheet column border where the columns are named and the mouse should turn into a double arrow which can be dragged to change the column’s width.
Title: Matrices with Quattro Pro

Suggestions for Other Activities

- Scalar multiplication can also be demonstrated using Quattro Pro by creating a 1 X1 matrix to contain the scalar multiplier. This 1X1 matrix can then be multiplied by any other matrix using formulas similar to those described in matrix multiplication and the copy feature. See Figure 3 for an example of this.

- The inverse of matrices may also be determined by first calculating the determinant.

- Systems of linear equations may also be solved using matrices.

Resources


- Corel Quattro Pro Help Menu
Appendix C

Grade XII Lesson Plans
Title: Dr. Math

Description

Students will use the Internet site called Dr. Math to answer questions about mathematics topics from the high school curriculum. Topics can include topics learned in class, homework, puzzles, math contests, or anything else related to mathematics. This lesson plan will require approximately one to two periods.

Readiness Activities

Students should:

- Be assigned specific topic areas related to their grade level.
- It is assumed that both students and teachers will have a basic working knowledge of Internet Explorer and search engines.

Materials

- A user ID and password for each student in the class.
- Ensure Internet Explorer is assigned to each student group.
Learning Outcomes

Curriculum

Students will: enhance their knowledge of various components of the curriculum, depending upon the questions asked.

Technology

(a) Students will access, evaluate, and select information using technology.

(b) Students will use technology to communicate information appropriately.
Title: Dr. Math

Instructions

Students can either search for Dr. Math by using a search engine or input the web address: http://www.swarthmore.edu/dr.math

Dr. Math can be used effectively in a classroom situation in several ways. Here are some suggestions:

* Students may Search the Archives by inputting keywords of mathematic topics of interest and browse through the topics that have been identified. The same question or similar questions may already have responses answered for them.

* Students may select Dr. Math FAQ* (frequently asked questions) to investigate common topic areas where questions have been previously posed to Dr. Math.

* Students may choose to search the archives by grade level and topic by choosing High School from the home page. Many topic areas and questions can be answered this way when the student finds either the same question or a similar question.

* If students don’t find anything related to their mathematics topic and are confident that they have done a thorough search, they may email their questions to Dr. Math. This should be used as a last method of gaining information as their response time can be quite lengthy.

* This activity will help your students learn how to do an effective search of an Internet resource, and will also help them realize that it is always better to use an existing resource than a new one.
Hints

- The teacher should visit the Dr. Math site to be comfortable with the methods of searching as well as the topic areas which may be researched.
- Students should be given specific topic areas such as negative

Suggestions for Other Activities

- Information gained from the Dr. Math Internet site can be presented to the class in either a oral presentation or a written

Resources
Title: E-mail a Prof.

Grade 12 Mathematics

Career Exploration

One-Computer Classroom or Computer Lab

Kerry Rioux

Description

Students will use the Internet to find a University/college and E-mail a professor in the Math field to discuss the first year program(s). This lesson plan will require approximately two periods.

Readiness Activities

Students should:

• have a working knowledge of Internet Explorer, Pegasus mail and Word Perfect.

Materials

• Computer lab for two classes. With e-mails the time frame for the assignment could be stretched to two weeks depending on response time.
Title: E-mail a Prof.

Learning Outcomes

Curriculum

Students will: gain insight into the expectations of math professors in the various fields in which they are interested.

Technology

Students will: enhance their knowledge of Internet Explorer, Pegasus and WordPerfect.
Title: E-mail a Prof.

Instructions

Students are to search the Internet to find a University/college they are interested in attending the following year. If undecided, a student can choose the university which a friend or relative has attended. Once in the university site they will in all likelihood find the Department for Student Services, e-mail listing of graduate students in the field of interest or the Math Department and locate an e-mail address of a person who may be willing to provide information in regards to the topics suggested below. (Many sites have individual addresses or a department address). Topics they may wish to discuss are:

a) requirements for admission.

b) the general areas of difficulty for first year students.

c) ways to be better prepared for these courses.

They will then prepare their findings on WordPerfect to submit to subject teacher. A class discussion on this topic may be beneficial.
Hints
Several common Maritime University sites could be on hand for students not decided on a location or are not planning to attend a post secondary institution.

Suggestions for Other Activities
Students could have discussion on how different universities have different expectations and how they could have an impact on which university/college they pursue.

Resources
Appendix D

Lesson Plan Forms
Title:

Subject

Grade

Application

One-Computer Classroom or Computer Lab

Reference/Teacher

Description

Readiness Activities

Students should:

•

Material

•
Learning Outcomes

Curriculum
Students will:

Technology
Students will:
Title:

Grade - Subject

Application

Instructions
Title:

Hints

Suggestions for Other Activities

Resources
Title:

Readiness Activities
Students should:
- 

Material
- 

Description
Title:

Learning Outcomes

Curriculum

Students will:

Technology

Students will:
Title:

Grade - Subject

Application

Instructions
Title:

Hints

Suggestions for Other Activities

Resources